Additional Notes About
3ds max™ 5.1 Web Update
This file contains the latest information regarding 3ds max 5.1. For continuously updated information on all Discreet® products, visit our website at:

http://www.discreet.com/

Installing, Registering and Authorizing 3ds max 5.1 from the Web Update Install

·	The Update Install is supported for use over 3ds max 5.0, only. Installation over an earlier 3ds max version (for example, 4.0, 4.01, and 4.02) is not supported.

·	When running the 3ds max 5.1 installation from the Update installer, if any C-Dilla based software is opened, or if the C-Dilla service is running, a message will display:

"Certain processes are running that will prevent the successful update of 3ds max 5.1. Please close any applications that may be open, reboot your system, and rerun this updater."

This message means that another application (e.g. 3ds max) that uses C-Dilla drivers is currently loaded. To correct this:

	Close 3ds max or the other C-Dilla based application and wait for the C-Dilla service to shut down (usually 15-20 seconds after you close the application)


	Terminate the CDilla64 and CDilla10 services using Task Manager.



	After the conflicting application has closed, clicking OK will resume the installation. Or canceling the installation, rebooting your computer, and restarting the installation will also solve this.


·	The folder c:\c_dilla is related to the 3ds max install and is required for 3ds max to run. Do not delete or rename this folder.

·	If the install is interrupted your serial number may become corrupted. If this happens you can rename the 3dsmaxexe.bak (that has been created in the 3dsmax root directory) to 3dsmax.exe and start the install process again.
Note About 3ds max 5.1 Features

THIRD-PARTY PLUG-INS AND SCRIPTS
·	Plug-ins and scripts developed for 3ds max 4 should work in 3ds max 5.1 without the need to recompile. Plug-ins using API calls outside of the version 4 SDK may need to be recompiled. 

·	While you probably will not need to obtain new versions of commercial plug-ins from their manufacturers, you might need to obtain a new authorization if the publisher ties its product to either the 3ds max version, serial number, or security ID. 

ACTIVESHADE
·	An ActiveShade floater or viewport updates every time a render element is added using the Render Scene dialog.

·	Changing the RectangleXYWH value in the [FloatingActiveShadeWindowRectangle] section of the 3dsmax.ini file has no effect on the ActiveShade window’s position or size.

·	Using Raytrace materials can cause the ActiveShade window to lose focus, activating the main UI keyboard shortcuts. Click the ActiveShade window to reactivate ActiveShade keyboard shortcuts.

ASSET BROWSER
·	Autodesk Voloä View is currently not supported.

·	The “Display obsolete file” message option does not apply to files that you drag and drop (as opposed to those that you open with File > Open).

·	Scene XRef drag and drop of files with scripts that depend on explicit scene object references can cause unpredictable results or program failure.

BONES
·	Bones creation behavior can be unpredictable when using Snap Override. When you use SHIFT+right-click to invoke Snap Override, the Bones system interprets this as a left-click and places a bone in the scene.

·	The Macro Recorder does not support Bones creation. However, you can manipulate the bones with the Macro Recorder after creating them.

·	When Reassign Root is used it deletes and recreates new bones. Any animated parameters, controller setups, and custom bone settings are lost, including IK chain assignments. You should use this tool before making any adjustments or IK assignments to your bones.

BOOLEANS
·	Edges created during a Boolean operation involving compound (nested) Booleans may be visible when they should be invisible. This affects only viewport display modes that display visible edges, such as Wireframe, Lit Wireframes, and Edged Faces. These edges can be made invisible through mesh editing.

CHARACTERS
·	Using the Unlink Selection tool on objects that are contained in Characters may produce unexpected results. Instead, use the specific tools provided Adding and Removing objects from Characters. Note similar warning with Groups.

·	Viewing Object Properties on Locked Characters, will cause all further Object Properties inquiries to show incorrect values for the Vertex and Face count properties. It is recommended that you Save and Restart max if this occurs, to avoid further instabilities that can result from this issue. Note similar warning with Groups.

·	Objects with animated TCB Rotation controllers may shift position when a containing character is destroyed. To avoid this, use Euler rotation controllers instead.

·	Adding groups to a character by selecting it from the viewport is not supported. Pick Object must be used to add characters to groups.

·	In some instances, the Character Error dialog may appear with no nodes listed. If this occurs, try reselecting or selecting part of your hierarchy and then using Add Member to add more objects to your character.

	Before entering the Skin Pose code for a character or group, it is advised to first set keys for all the members. The easiest way to do this is to click Set Key Pose.


COMBUSTION MAPS (FORMERLY PAINT*)
·	Loading IPP files from paint* is not supported. To use an IPP file, load it into combustion and save it as a CWS file.

·	combustion needs to be installed on your system in order to view CWS files. It should also be installed on all network-rendering servers if you are going to net-render a scene that contains CWS files. combustion does not need to be authorized to process CWS files used within 3ds max net-rendering servers, but does need to be present.

·	CWS files that were created as “rub-throughs” won’t display unless combustion is installed on your computer.

·	In the Combustion Parameters rollout, when Track Time or Custom Resolution > Enable is turned on, viewport selections are not highlighted.

·	When you use a Combustion map with a Displace modifier or as a projector light map, the scene will not render correctly while a live link exists between 3ds max and combustion. To render correctly, save the loaded workspace file, and then turn off the Edit button to terminate the link between 3ds max and combustion.

·	Using the Combustion map (within 3ds max 5.1) with combustion and attempting to change the UV Coordinates while Unwrap is selected and the Unwrap operation is visible in combustion, you might experience a disconnection error in 3ds max. To correct this, verify that all your UV settings are in place before you attempt to edit your map within combustion. The disconnection alert only appears when you have an object selected in your scene, so if you unselect your object and change the Unwrap UV channels, no disconnection alert should appear.

·	The UV Offset values in the Coordinates rollout of the combustion map are not honored when painting directly on the object in 3ds max 5.1. To offset the UVW Coordinates of the combustion map, apply a UVW Map modifier and a UVW XForm modifier.

CONTROLLERS
·	In 3ds max 5.1, the default controller assigned to the Path Constraint Percent parameter has been changed from Bezier Float to Linear Float. In addition, Constant Velocity is ON by default. This change was required in order to provide by default a smooth motion at a constant velocity.

Third-party plug-in developers should be aware of this change of default controller especially if their code assumes that the data comes from a Bezier Float controller. Because Bezier keys and Linear keys have different signatures, their code should test the type of controller assigned to the Percent parameter and do the some data conversion as necessary.

A data conversion could be done this way:

Control* linCtrl = CreateInstance(CTRL_FLOAT_CLASS_ID, Class_ID(LININTERP_FLOAT_CLASS_ID,0)); 	// create a Linear Float controller.
linCtrl->Copy(bezCtrl);	// copy the keys from the Bezier controller to the Linear controller.

pblock->AssignController(linCtrl, pblock->GetAnimNum(path_percent));  						// shouldn't assume that the percent controller is
hardcoded to 0.

·	SHIFT+cloning path-constrained objects might not position copies properly. Creating clones of a path-constrained object using the SHIFT+Move technique will not evenly space each clone from its previous sibling.

·	The Boolean controller is the new default controller for check boxes, replacing the On/Off controller. It is recommended for use with Set Key because the value of a Boolean keyframe is either 0 or 1, whereas the value of an On/Off keyframe represents a change in value. Use of the Boolean controller with Set Key will preserve the current keyed state. An On/Off key will change the current state to the opposite one.

·	There is currently no Action Item for Gimbal coordinate system.

·	In 3ds max 4, the TCB Controller was enhanced with the capability of performing quaternion rotations of greater than 180 degrees. This enhancement allows objects to be “wound up” interactively in the viewports. This enhancement produces a side effect when editing rotation keys in the timeline or in Track View. As a general rule, a quaternion rotation takes the shortest path between rotation poses. However, when editing TCB rotation keys using Delete, Cut and Paste, or Drag and Drop, or if keyframes are added in the middle of existing keyframes, the animation near the edited keys might rotate opposite to its original direction. That is to say it takes the long way around to arrive at the same pose at the next keyframe. If this is undesirable, there are several remedies:

In 3ds max 5.1 a Rotation Windup check box has been added to the Motion panel for TCB. When off, the rotations are limited to <180 degrees. This will preserve any editing of rotation keyframes. When on, rotations larger than 180 degrees are possible. It is recommended that you leave Rotation Windups off until you require it for specific animation.

You may also want to change to the Euler XYZ controller, which will always produce correct rotation poses after editing, regardless of windups at any keyframe. Euler XYZ is the default for 3ds max 5.1.

·	If an older scene containing a Local Euler controller is loaded into 3ds max 5.1, it will be recast as Euler XYZ. The animation data and resulting animation will be precisely the same.

·	NURBS Point controllers should be individually reassigned from the Surface sub-object level rather than at the Master Controller level in Track View in order to see their effect.

·	Master Point controllers are compound controllers, and depend on sub-controllers and their structure; therefore you cannot cut and paste Master Point controllers.

·	Adding a float list controller to a property with no keys, then adding a Bezier or TCB float, followed by a procedural float controller (noise or waveform, for example) might cause product instability. To avoid instability, make sure that animation is applied to the object before you add the controller.

CREATE PANEL
·	Using sub-object mode hotkeys (Number keys: 1, 2, 3, 4, or 5), while creating Shape objects will cause unrecoverable instability in 3ds max. If this occurs, exit and restart 3ds max.

CUSTOM ATTRIBUTES
·	Making a copy of a material that has custom attributes also copies the custom attributes. Any custom attribute changes then affect both materials. Using Delete All to delete the Custom Attributes rollout on the copy should end this behavior.

·	The default value in the Integer UI Options rollout is ignored when creating a new Integer custom attribute. The value in the Float UI Options rollout is used instead. When creating a new Integer custom attribute, set the default value in the Float UI Options rollout first, before defining the other values in the Integer UI Options rollout.

DAYLIGHT (IES SUN & SKY)
·	Even though IES Sky has a slider to control the Sky cover, the slider will not work gradually, but will instead display three different sky intensities. This is becasue the IES Sun and Sky intensity are calculated according to the “IES RP-21 Calculation of daylight availability” standard. This standard considers only three levels of sky coverage and considers the sky as emitting 0 lux/fc once the sun is below the horizon.

·	The positioning controller of the Daylight system does not exactly correspond to the one described by the “IES RP-21 Calculation of daylight availability” standard, thus resulting in slight intensity variations at certain times and locations.

DEPTH OF FIELD
·	Using Atmospheric Effects with the Depth of Field rendering effect is currently not supported.

DOPE SHEET EDITOR
·	Performance may degrade when moving or coping keys for objects requiring intensive re-calculations based on previous keys (for example HD IK.).

DISPLAY
·	Direct3D® display may not work correctly on video cards with less than 32 MB of video memory. 64 MB is recommended to access the maximum number of Direct3D abilities. 

·	Direct3D "best" mode transparency requires that the video card support d24s8 textures and have a z-comparison operator function to display correctly. Cards that do not support these features will use "simple" transparency mode instead.

·	Direct3D Metal Bump viewport shader only supports .dds files as cube maps.

·	Wave, Ripple, Bomb, Drag and UDynaFlect space warps will display with incorrect coloring under Direct3D. 

·	Some video cards might display only half the lines on wireframe objects. To fix this, turn off the toggle Use Wireframe Faces (Custom Driver Extension) in the Configure OpenGL dialog, located under Customize > Preferences > Viewports panel.

·	Viewport antialiasing of shaded geometry is not supported under Direct3D or OpenGL®.

·	Running 3ds max 5.1 with the track bar UI hidden can increase viewport performance. The track bar UI can be turned off through Customize > Show UI and turning off Show Track Bar.

·	Running 3ds max 5.1 with some Matrox cards can cause the 3dsmax.exe process to remain in the task manager after closing 3ds max. 

·	Running 3ds max 5.1 under D3D with Microsoft NetMeeting® may cause display problems or product instability.

·	The Metal Bump shader is only supported for Editable Mesh objects.

·	Direct3D does not support two sided display for materials.

DYNAMICS UTILITY
·	The Dynamics utility is included within 3ds max 5.1 for legacy files only. For superior results, use reactor™ for any dynamics simulations. The Dynamics utility will not be supported in future versions of 3ds max. 

EDITABLE MESH
·	The Redraw Viewports shortcut key 1 doesn’t work with Edit Mesh or Editable Meshes. To fix this, go to the Customize > Customize User Interface dialog, Keyboard tab, under Group: Edit/Editable Mesh, and remove the shortcut (1 by default) assigned to Vertex Level.

·	3ds max 3.x files that have a stack where an Edit Mesh modifier containing sub-object collapses is above a MeshSmooth modifier, may load into 3ds max 5.1 with missing faces and distorted geometry. To correct, load the scene in 3ds max 3.1 and collapse the object to the highest MeshSmooth level in the stack (that's under the Edit Mesh modifier with sub-object collapses) and save that file.

EDITABLE POLY & POLYMESH OBJECT
·	For Cylinder or Cone primitives with three or more cap segments, some types of polymesh conversions can cause duplicate faces; these include Boolean, Poly Select, Convert, and Collapse. To avoid this problem, add a Turn To Poly modifier to the object first.

·	If an Editable Mesh has face normals flipped in a non-uniform manner, converting it to an Editable Poly can cause problems. The conversion process attempts to divide the object into elements to keep a legal condition. The division method might be unpredictable and will probably be based on how many vertices are shared between flipped and non-flipped faces. Unifying the normals before conversion is recommended. Or, you can detach the flipped faces as elements before conversion, and the elements will be respected by the Editable Poly conversion. This ensures a more orderly and predictable conversion.

·	Interior patch edges that are not displayed will always appear as visible edges after converting to a polymesh.

·	Pasting animation using Copy or Instance into animatable spinner fields is not supported for Editable Poly. Copying or pasting the controllers in Track View will achieve the same functionality.

EXPOSURE CONTROL
·	Turning on Process Background will not render Background Color. Bitmaps and texture backgrounds render correctly, but simple background color does not. A workaround is to use a checker map with the two colors equal to the background color.

FILE I/O
·	3DS files created by the Rhino product (from Robert McNeel & Associates) can cause instability when imported into 3ds max. If an assert error dialog is encountered, using Retry may result in a successful import, but this might cause your session to destabilize.

FILE MENU
·	3ds max 5.1 files are backward-compatible with 3ds max 5.0, but not with previous versions of 3ds max, and will not load within earlier versions. 

FLEX
·	Flex single-frame rendering can take a substantial amount of time. When a scene containing Flex is rendered at a point in time far away from the Flex reference frame, the modifier must calculate the solution for all flexed points from the reference frame to the current frame. During single-frame tests or net rendering, this could contribute to a significant delay in overall rendering time. To correct this, add a Point Cache modifier above Flex and record the flexed point data to disk. Then, disable all modifiers below Flex before you render.

GROUPS
·	Grouped objects that have animated TCB Rotation controllers may shift position when the object is removed from the group. To avoid this effect, use Euler rotation controllers instead.

·	Viewing Object Properties on Closed Groups will cause all further Object Properties inquiries to show incorrect values for the Vertex and Face count properties. It is recommended that you Save and Restart max if this occurs, to avoid further instabilities that can result from this issue. Note similar warning with Characters.

·	Using the Unlink Selection tool on objects that are contained in Groups may produce unexpected results. Instead use the specific tools provided for Attaching and Detaching objects from Groups. Note similar warning with Characters.

HSDS 
·	Using HSDS on a mapped object breaks vertices and can distort the texture. This is a limitation, as there is no provision for more than one texture vertex per vertex. To work around the problem, texture the output of HSDS instead of the input. 

INI FILES
·	Before editing 3dsmax.ini, or any other INI file, it is advised that you save a copy for backup. You can restore your 3dsmax.ini to factory defaults by removing it from the root 3dsmax5 folder and starting 3ds max.

INVERSE KINEMATICS
·	Invalid IK dependency loops might not trigger a warning. It is possible to create an IK dependency loop that generates an undesirable solution. No warning is given to indicate this occurrence; however, the results are generally evident immediately and usually undoable.

·	Setting joint limits on HI IK start joints might lead to nonintuitive behavior. The joint limits on a start joint might interfere with the HI requirements to create an IK solution. In this event, the resulting configuration of the chain might be unexpected. To correct this, free up as many degrees of rotational freedom as possible. It can also help to adjust the preferred angles of the start joint.

·	A conflict may occur when you have an HI IK chain and use Assign Vertex Colors on the bones that make up that chain. This conflict may cause subsequent file load problems. To correct, either collapse the stack after using the Assign Vertex Colors utility, or add a VertexPaint or STL Check modifier to the top of the stack.

	For HI IK, no MAXScript or parameter wiring is available for the Enabled state. This is as designed, as the Enabled state is controlled by the new Boolean controller, which can be copied and instanced.


LAYERS
·	When the Layer’s Shaded Viewport Display is used, it will be set to Facet if the viewport itself is displayed in non-Smooth mode. Once the viewport is set to Smooth + Highlights by right-clicking the viewport label, this will change the Layer’s default Facet display to Smooth.

·	Display As Box under the Display Properties does not work for layers set to Wireframe display. To use Display As Box in Wireframe mode, set the Viewport Display to Viewport and have it be in Wireframe there.

·	Scripting Access only allows turning on, off, lock, unlock, name, wirecolor, includeGi, and excludeGi. Advanced parameters are not exposed to MAXScript.

LENS EFFECTS
·	A glow of small size doesn't appear to work when rendering to fields. To correct this, increase the size of the glow before rendering.

·	Glow, on an Environment map, using Effects ID, will not work if Anti-Aliasing is on.

·	Resetting 3ds max while the Video Post Lens Effects Setup dialog is displayed is not recommended.

LOFT
·	Setting Loft output to Patch and then setting Path Parameters to Path Steps can cause an application failure. If using Path Steps if desired, it is recommended that the loft be set to Mesh output.

MACRO RECORDER
·	Not all features are macro-recordable at this time.

MANIPULATORS
·	When entering text into the Label field for a Slider, Manipulate mode must be turned OFF. Otherwise, text will be reversed.

MATERIAL EDITOR
·	Blur and Blur Offset controls are enabled for all 3D maps, but can be used only with antialiased 3D maps such as Noise.

·	If textures are not found on merge, use File > Open instead of Merge.

·	The Make Unique button in the Material Editor also works on the map level of a material when you have a map instanced to different channels of the same material.

·	Installing Microsoft Access® after installing 3ds max 5.1 results in the MAT file type being reassigned as an Access table file and not a 3ds max materials library file. To correct, use Windows Explorer > View > File Types to reference the file type back to 3ds max 5.1.

·	Texture-mapped objects that are invisible at frame 0 and are missing UVW mapping coordinates will not be textured in a rendered sequence when visibility is changed during the animation. To alleviate the problem, make sure to have a UVW Map modifier on the object.

·	The use of recursive IFL files is not supported.

MERGE ANIMATION 
Merge Animation no longer supports character studio Biped animation. character studio 4 features support the merging of Biped animation.

	When using Merge Animation at the sub-object level, the target object will first need to have sub-object animation controllers assigned to its vertices. Merge Animation does not automatically assign sub-controllers to vertices, CVs or control points. For example, when merging FFD lattices, you must click Animate All before merging lattice control points. 


	It is wise to make sure that the target object has a Vertex controller (Bezier Point 3 or similar) assigned to every vertex in its mesh. There must be a one-to-one correspondence between the animated vertices of the source nodes and the target nodes in the scene to achieve predictable results.


	There is a known issue with Groups, which can cause Merge Animation to fail.  This sometimes occurs with objects that were once part of a Group but are no longer, leaving a flag for Group membership incorrectly set on the object. One way to clear this flag is to make these objects part of a Character (then destroy Character if desired). Alternatively, in MAXScript this will clear the flag for selected objects:


for n in selection do ( setGroupMember n false )

	Merging .max files that contain Xref into the current scene is not advised.


	Merge Animation errors can sometimes be avoided by exiting and reopening the Merge Animation dialog, especially when merging animation more than once.


MESHSMOOTH 
·	When using Smoothness on a mesh that has had control-level editing, Smoothness will smooth down to the highest level that has had control-level editing applied to it, or to the currently active control level, whichever is higher.

·	At this time, control-level editing in MeshSmooth should be considered a modeling tool only. Having an animated deformer placed before a MeshSmoothed object that has had control-level editing can result in the MeshSmoothed object becoming distorted. It's recommended that deforming modifiers be placed after the MeshSmooth modifier in the stack if you're using the deformers for animation. For best results, using a deforming modifier before the MeshSmooth modifier in the stack, you'll need to limit your control-level edits to moving vertices in their local Z axis.

·	Using MeshSmooth with values of more than 10 iterations is not supported.

·	When MeshSmooth is set to 0 iterations, a polygon conversion of the MeshSmoothed object still occurs and viewport performance will be impacted. For optimal playback, set the MeshSmooth modifier to be OFF in viewports, rather then setting iterations to 0.

MODIFIERS
·	Changes to the alpha value of a sub-object cannot be undone in an Editable Mesh if you type the number in the Alpha field. Use the spinner instead.

·	Using PathDeform and Stretch can leave remnants in the viewport. Press 1 to refresh the display.

·	A Helix object with Display Render Mesh On that uses an FFD modifier will no longer appear in the viewport if an Edit Mesh modifier is added to the stack. To correct, convert the Helix to an Editable Spline by either collapsing or adding an Edit Spline modifier somewhere before Edit Mesh.

MORPHER
·	Assigning a Morpher material will reset fame zero Morph Channel values to zero. To avoid this, use Set Key to set non-zero Channel Values at frame zero. The frame zero value may appear to be reset, in this case, but scrubbing the time slider will then update the frame zero value, as set previously.

·	Windows 98 or Windows ME may loose adequate system resources (UI elements may no longer display) through scrolling the Morpher Channel List, repeated interaction with Morpher scene elements, or simultaneous use of 3ds max with other applications that require large amounts of resources. To resolve the problem, save your file, exit, and restart 3ds max, or close the other resource-intensive applications. If possible, avoid excessively scrolling the Morpher UI when using these operating systems.

·	When adding new targets to a progressive morph, target percents will be renormalized. If target percents have been customized, it is recommended that you make a note of current target percents before adding new targets.

MORPHER MATERIAL
·	Copying Morpher material to different Material Editor slots can cause unexpected results, particularly if using Undo and Redo. 

·	Morpher material requires associated geometry to work correctly with Set Key.

MOTION PANEL
·	When a trajectory of an object is derived from a spline using the Convert From feature, the Previous Key and Next Key buttons on the Key Info (Basic) rollout do not work unless Time Display (in the Time Configuration dialog) is set to FRAMES:TICKS. This is because the keys are created between frames.

MULTIRES
·	Instanced MultiRes modifiers will display their Vertex Percentage values, and will hide their Vertex Counts, when more than one object is selected.

·	The MultiRes modifier currently does not support materials applied to any channels other than channel 1. UVW mapping coordinates, for channels other than channel 1, can be reassigned with a UVW Map modifier applied above the MultiRes modifier in the modifier stack.

·	When using Set Key, remember that the MultiRes modifier detects any keys that are set on object parameters as changes in the underlying object's mesh, and this may require the MultiRes mesh to be regenerated.

NETWORK RENDERING
·	Network Render jobs may only appear to submit for scenes with Camera names containing the string: "<_". Remove underscore or the less-than sign to correct the problem.

·	If you uninstall 3ds max 5.1 and then reinstall 3ds max 5.1 with backburner in a different folder than it was originally installed in, you will need to remove the old path to backburner from the windows path environment variable. On your desktop, right-click the My Computer icon, choose Properties, Advanced tab, Environment Variables, choose the Path system variable and click Edit. Remove the old path to backburner.

PARAMETER WIRING
·	Wiring a parameter to a value outside the constrained range of that parameter can cause unpredictable results.

·	Turning on Display Render Mesh after wiring a NURBS point curve can cause instability. The workaround is to assign a Bezier float controller to the curve's Sides track and insert a key. Values can then be changed, and Display Render Mesh can be used without problem.

PARTICLE SYSTEMS
·	Using PArray with an Object-Based Emitter and Object Fragments where the emitter object has no vertices on the Emit Start frame will cause instability, leading to an application failure. 

·	When the source particle system of a Mesher compound object is set to Mesh Viewport Display, it will not update properly in viewports. Use the Dots or Ticks Viewport Display options with a Mesher compound object.

·	SDynaFlect space warps do not solve properly in Dynamics simulations.

PLUG-IN MANAGER
·	Under Win98 and WinME, plug-ins that are currently loaded are marked as "Unloaded" instead.

·	The Load option for selected or tagged plug-ins loads a plug-in for the current 3ds max 5.1 session, but doesn't load for subsequent sessions.

·	Plug-ins loaded using the script function "loadDllsFromDir" do not appear in the Plug-in Manager.

QUAD PATCH
·	Performance is slow when creating Quad Patches with 100x100 segments.

RADIOSITY
·	After changing some objects in the scene, the radiosity solution may continue using the previously set parameters, even after resetting the solution. This is because the Reset Radiosity dialog was set to not be displayed again, and the solution always continues processing using the previous database. To redisplay the dialog, edit the discreetradiosity.ini file, located in the \plugcfg folder, and change

 		InvalidResetDlg=0 to InvalidResetDlg=1. 

	Then, when choosing Reset All in that dialog, the objects that changed will be reloaded.

·	For best result, always use Exposure Control when working with radiosity.

·	If you try to edit a scene material after you process radiosity, the system response might be slow and even appear locked. In fact, the system has not locked, but is processing redraws for every change in every object containing the material. Potential workarounds would be to reset the radiosity solution prior to performing material edits or assigning a new material to the object prior to editing.

·	Do not use Views > Activate All Maps after processing a radiosity solution. This may take a long time to process and your system may appear locked. Reset the radiosity solution before using it.

·	Changing an object's layer (when its properties are set to By Layer) will not invalidate a radiosity solution. You need to do a Reset All and reprocess radiosity to update the radiosity solution with the new settings.

·	After processing radiosity, some maps might display incorrect colors in the viewport. To fix this, make sure you turn on Show Map In Viewport for the parent material, not for the map.

·	Radiosity does not support Light Include/Exclude lists.

·	Coincident faces may cause artifacts with radiosity calculations. Splines using an Extrude modifier with an Extrude Height of 0 and both Cap Start and Cap End turned on usually produce coincidental faces. To correct, turn one of the Cap options off, or make the Extrude Height > 0.

·	Rectangular or scaled spotlights are considered as standard conical spotlights by the radiosity solver.

·	Radiosity does not distinguish lights where Affect Ambient, Specular, or Diffuse is toggled. All are treated the same way. If you need these lights to affect only the specified channels, exclude them from radiosity.

·	When objects are excluded from radiosity, they will render black when using “Re-Use Direct Illumination From Radiosity Solution”. If you want to avoid rendering Direct Illumination, you can Store Direct Illumination for all lights and add lights that are excluded from radiosity.

·	Creating new splines (not renderable), helpers, and cameras will not invalidate the radiosity solution. However, if you apply a modifier to a 2D spline and convert it to a 3D object, it will still not show the solution as invalid. On the other hand, as soon as you click Start, radiosity will recognize the new object and will then warn you that the solution is invalid and needs to be reset.

·	Opening previous 3ds max scenes sets “Compute Radiosity When Required” to On by default. 

·	Radiosity does not support Wireframe materials. Use the Lattice modifier or an Opacity map to get the desired affect.

·	In 3ds max 5.1, radiosity is computed based on the ambient color. If you have old files where the ambient color is different or darker than the diffuse color, your scenes might render unexpectedly. For predictable results, either lock the ambient and diffuse color or at least to make them very similar. Autodesk® VIZ 4 only uses the Diffuse color to compute radiosity, so results from it may be dissimilar from those in 3ds max 5.1.

·	Radiosity does not support materials with the Face Map toggle turned on. Objects need to have explicit UVW coordinates. To use Face Map, apply a UVW Map modifier to the objects, and choose Face. This has the same effect as turning on Face map in the material.

·	When using XRef Scenes, and the XRef Scene has been changed, the radiosity solution will not be automatically invalidated. You need to click Reset All and restart, so the radiosity solution can be updated.

·	Files that contain radiosity solutions are usually very large. If you turn on Compress On Save in Customize > Preferences, files will reduce significantly in size. 

RAYTRACE
·	Using the Raytrace material on double-sided materials is currently not supported.

·	It is almost always better to use supersampling, rather then antialiasing, at the material level. The only time you might want to use Raytrace antialiasing is to blur or defocus reflections or refractions. If you do use Raytrace antialiasing, the default blur value, 0.0, is usually too small. Try using 0.5 or 0.6 and set all of your materials that use the Raytrace map to Adaptive Halton supersampling to improve image quality.

·	Some 3ds max 4.2 files using Raytrace maps in the refraction map slot of a standard material shader may render slower in 3ds max 5.1. To improve performance, go to the Raytrace maps in your scene, open the Refractive Material Extensions rollout, and turn off the Treat Refractions as Glass (Fresnel Effect) check box.

·	3ds max 4.2 MAX files using Raytrace maps in the refraction map slot of a standard material will render differently than in 3ds max 5.1 due to improvements made in refraction map.

REACTOR
·	reactor 1.5 is included with 3ds max 5.1 and no additional authorization is required. To start reactor, click the reactor button on the Utilities panel.

·	reactor 1.5 requires the presence of DirectX version 8 or higher installed before being able to successfully load into 3ds max 5.1.  For your convenience, you may install DX 8.1 from the 3ds max 5.1 CD or go online at:

http://www.microsoft.com/windows/directx/downloads/default.asp

·	The interactive reactor preview uses its own graphics display. Some older graphics accelerators that only do full-screen acceleration will run slowly in software windowed mode. To use 3D hardware acceleration on these cards, check the full screen option before previewing the scene. If you experience problems that include the above mentioned render problems or issues that prevent the preview window from running (blank, black screen, or the window hanging), please contact Discreet Product Support with information about your card: chipset, manufacturer, driver revision, and operating system information (including service pack version) so we can work to correct it. 

·	In the case of a scene not completing a Solve, there are various ways of simulating the same scene:

	Take your original scene and increase the substeps/keyframe value (Animation & Export rollout).


	Increase the collision tolerance for your scene so that it’s approximately 1/10th of World Scale (Advanced rollout). If this increase causes too large a gap between objects, scale the objects up and scale gravity up by an equal percentage.


	For keyframed and deformable objects, increase the updates/keyframe value.


·	The addition of body or collection types to a scene can change the scene’s simulation. Adding types of objects will not usually have a noticeable affect on the scene’s simulation but it is advisable to create scenes as nearly complete as possible, before tweaking the parameters for a desired result.

REGATHER
·	Rendered images may look inconsistent when rendering with a number of rays per sample smaller than 40 on systems with two or more processors. Differences will also be noticed between Autodesk VIZ 4 and 3ds max 5.1, because 3ds max 5.1 supports multi-threading for Regather while Autodesk VIZ 4 does not. 

RENDER ELEMENTS
·	Adding Render Elements to a newly opened file does not mark the scene as modified. To correct, save the scene before opening a new scene or closing 3ds max 5.1.

·	Scenes from 3ds max 4 with Z Depth render elements load incorrectly when filtering is enabled. To correct, disable filtering for these elements within 3ds max 4 prior to loading in 3ds max 5.1.

·	The Diffuse and Shadow elements might have unexpected results when rendering with Light Tracer.

RENDER EFFECTS
·	The File Output render effect does not support network rendering.

RENDERING
·	When rendering scenes containing more than 5 million polygons, increase your virtual memory to 1.4 GB or higher for better performance. 

·	Image Motion Blur is a memory- intensive operation requiring a large amount of RAM that scales linearly with the number of pixels in the rendered image. You may not have sufficient memory to allocate the image motion blur buffer if you are also using high-resolution background maps. To correct, composite the blurred image against the background image in postproduction rather then rendering when Image Motion Blur is calculated. 

·	Texture-mapped objects that are invisible at frame 0 and are missing UVW mapping coordinates are not textured in a rendered sequence when visibility is changed during the animation. To alleviate the problem, make sure to have a UVW Mapping modifier on the object.

·	When rendering Fields with Image Motion Blur and Work With Transparency turned on, the final images might contain artifacts.

RENDER TO TEXTURE
·	A warning will be displayed when you use Render To Texture on a patch object, and results may be less than satisfactory if you choose to continue. For best results, add either a Turn To Mesh or UVW Unwrap modifier to patch objects before using Render To Texture.

RESOURCE COLLECTOR
·	The Resource Collector does not collect Environment, Displacement, or Projector maps.

·	The Resource Collector does not collect the image files used by IFL files, only the IFL file itself.

·	The Resource Collector does not collect the objects or scenes referenced by XRef Objects or XRef Scenes.

SCHEMATIC VIEW
·	Compound objects cannot be renamed.


SET KEY
·	Set Key requires a controller to be present to create a key. While all objects have default controllers for their transforms, object parameters do not. Controllers must be assigned to these entities before Set Key can create keys for them. 

·	Leaving Set Key on during material creation can lead to unexpected results. It is recommended that you turn Set Key off while setting up materials and maps.

·	Set Key action items will only work with XYZ controllers. For all other controllers, use Keyframe Tools action items. Note that 3ds max 5.1 now defaults to XYZ controllers.

·	Set Key does not respect the changes made in the active material, unless you have enabled the Set Key Material Filter.

·	Set Key does not fully support the animation of Manipulator helpers, and using them can result in unpredictable results. Manipulators should be used with Auto Key.

·	Block controllers do not work with Set Key-only animation. If the Block contains an object animated with Auto Key, then all objects animate correctly. The Auto Key object can be a simple dummy, and it can be deleted after the block is created.

·	The Follow/Bank utility does not support Set Key animation.

 SPLINE IK
	The default sub-controller for the first bone of the Spline IK bone chain is now Path controller. The first bone may be animated interactively, just as with any object with Path controller and the other bones in the chain will follow.


	Bones that continue past the end of a spline will maintain current orientation to their parent bones rather than snapping to a 0,0,0 rotation as they did in 3ds max 5.0. This allows bone chains to be predictably path-animated off of the end of the spline.


	Spline IK now allows for the inclusion of the spline, spline helpers, IK handle, and bone chain in the same hierarchy. 


	Spline IK will now preserve the arbitrary X-rotation of the bones in a chain after Spline IK is assigned.


	The preferred angles for each bone under Spline IK control are accessible in MAXScript, although not exposed in the user interface as with HI IK. Generally, only the X axis should be manipulated, as with Twist, since the Y and Z axes are always used by Spline IK to fix the bones to the spline. This value can be accessed with “$.controller.prefXAngle”


	It is possible that some Spline IK chains, created in 3ds max 5.0, may load into 3ds max 5.1 with bones arbitrarily rotated about their X axes. This can occur if the bone chain was created in 3ds max 5.0 with arbitrary X-rotations before Spline IK was assigned (after the assignment Spline IK would have automatically aligned the bones X-axes ). If such a scene is loaded into 3ds max 5.1 the bones may “revert” to their creation orientations.  If it is necessary to realign the bones, the bone chain can be reoriented using MAXScript. For example, select all the Spline IK bones (if the first bone in the chain is already properly oriented, deselect it) and run: 


for n in selection do ( n.controller.prefXAngle = 0.0 )

	It is possible that some Spline IK chains, created in 3ds max 5.0, may load into 3ds max 5.1 with bone chains entirely flipped about their local X axis. If this occurs, the bone chain can often be reoriented by adjusting the Spline IK Twist Start Angle.


	Spline IK will only work when referencing a shape or spline object, meaning the referenced object’s stack must end as a spline (i.e. Shape). Modifiers may be used on the referenced spline so long as they do not convert it to another geometry type.


SUBDIVIDE MODIFIER
·	The Subdivide modifier cannot be applied to NURBS Curves, even if they’re renderable curves. Instead, use the Subdivision Properties to adjust the curve's mesh density.

·	Very low Size values can exhaust system memory and cause session instability because Subdivide will create extremely large quantities of faces. Be sure to use reasonable Size values. If subdivide is taking a long time to calculate, use the ESC key to abort the subdivision, then set the Update method to Manual so you can change the Size value to something more appropriate.

TRACK VIEW
·	Track View hotkeys will not work if application focus is in subordinate windows, such as floating toolbars and soft-selection settings. To use Track View hotkeys, click the Function Curve or Dope Sheet editor title bar to replace focus there.

·	Deleting the trackview.ini file may cause icons to disappear. To resolve this, try loading the trackview.ini file from the 3ds max 5.1 CD. This action will bring your Track View settings back to their default values.

TRANSFORM TOOLS
·	Transform tools will not update while dragging at a sub-object level.

·	The Transform gizmo may disappear when snaps are enabled at the sub-object level. Passing the cursor over the missing gizmo will cause it to reappear.

TRANSFORM TYPE IN

·	The Transform Type-In controls on the status bar don't re-enable properly after you've been in a sub-object mode. To correct this, deselect and then reselect the object.

USER INTERFACE / CUI

·	Tab Panel behavior has changed in 3ds max 5 to simplify workflow.

	Tear-off Tab Panels create copies:  In 3ds max 5 and earlier releases, Tab Panels could be "torn off" using a click-hold-drag motion.  This action would convert the selected tab panel to a floating tool bar that could then be docked or re-converted to a tab panel.  In 3ds max 5.1, this same tear-off action still yields a floating tool bar, but preserves the existing tab panel in its original location.  The name of the new floating tool bar is identical to its original tab panel, with the addition of a numeric suffix.  For example - tearing off the "Compounds" tab panel, yields a new floating tool bar named "Compounds1", and preserves the original "Compounds" modify in place.  


	Convert to Toolbar changed to Copy:  Related to the tear-off behavior change, the right-click menu option for tab panels, which previously allowed for conversion directly to a tool bar, has been changed to only provide a copy of the tab panel as a floating tool bar.  Specifically, the right-click menu option that was named "convert to tool bar" now reads "copy to tool bar".


	No conversion of Tool bars to Tab Panels:  Floating and docked tool bars may no longer be moved to the tab panel area using the right-click menu option called "Convert to Tab Panel".  This right-click menu option has been removed.  As a result, Tool bars can only be deleted through the Customize->Customize User Interface-> Toolbars "delete" button.  Previously, tab panels could be torn off and then converted back to tab panels using the  "convert  to tab panel" right click mouse option.


	No delete of Tab Panels: The right-click tab label menu item "delete tab" is no longer available.


·	CUI files created in versions of 3ds max, prior to 3ds max 5.0, are not forward-compatible. These files need to be re-created for use in 3ds max 5.1. 3ds max 5.0 CUI files are compatible with 3ds max 5.1

·	CUI files should not be removed from the UI folder. If 3ds max 5.1 looks for a CUI file that is not in the UI folder upon startup, the application can fail. This can be a problem if multiple users are using the same configuration settings, but don’t have the correct CUI files associated with that configuration.

·	The proper highlighting of UI elements (mainly check boxes and radio button settings) might not appear in the command panel during keyboard tabbing when running 3ds max 5.1 under Windows 2000. To force the highlighting to display properly, undock the command panel. Then the highlighting will display and properly show where UI focus is. Once you have tabbed while the command panel is floating, you can redock the command panel, and highlighting will operate properly.

·	Large fonts are not supported in 3ds max 5.1, and can produce unpredictable display results.

·	The grid draw options drop-down list in Advanced Options is not supported. 

·	When working with memory-intensive files and processes, you may notice that the tools below the track bar disappear. Simply click the Maximize/Restore button at the upper-right corner of the application’s window. This will cause the missing tools to redraw at the bottom.

·	When 3ds max 5.1 is started the first time, the toolbar icon for the override keyboard shortcut will appear to be off even though the function is active. Click the button once to turn this function off. The button will stay in a non-active state. Click it again, and the desired functionality will follow.

·	If you want your system to default to your keyboard shortcuts from 3ds max 4, copy your keyboard shortcuts over as maxkeys.kbd. into the 3ds max 5.1 \ui folder.

·	Closing the Customize User Interface without saving will automatically save the KBD file.

UVW MAP
·	UVW maps assigned below a Disp Approx (displacement approximation) modifier may block changes made at the Displace Level. Setting the UVW modifier to Off in the viewport solves the updating problem.

UNWRAP UVW 
·	Normals mapping with Patches is not supported by Unwrap UVW.

·	Unfold mapping with Patches is not supported by Unwrap UVW.

·	Unfold mapping with Selected Faces can give unexpected results and is not recommended.

·	In certain patch models, the Stitch operation can cause tangent handles to be welded when Align Clusters is turned on. Turning off Align Clusters should solve the problem.

·	When there is a sub-object selection below Unwrap UVW in the stack, the Unwrap modifier uses those faces and disables its own Select Face sub-object mode. Closing the sub-object selection below the Unwrap will allow you to enter the Select Face sub-object mode in Unwrap by clicking the title bar, then the sub-object plus symbol in the stack will refresh after changing to another panel and back.

·	The Sketch Vertices feature should be used with the interactive feature On, as having it Off can lead to situations where Undo will not work.

·	Adding Unwrap to a closed spline and performing a Flatten Mapping operation is not supported. The spline should be converted to a mesh or poly and edited in some way (extruding, for example) before flattening occurs

·	In certain circumstances, the Brightness of the Edit Dialog background will be set to 0, which will result in the bitmap not being visible in the Edit Dialog. To fix this, click on the Show Options button in the lower toolbar and increase the Brightness spinner value (0.5 is the default), or open the Options\Advanced Options floater and increase the Tile Brightness or uncheck the Affect Center Tile checkbox. You can then choose Options\Save Current Settings As Default, and you should not run into this problem again.

VIDEO POST
·	Close the Video Post Lens Effects setup dialog before you choose File > Reset.

·	Lens Effects Focus does not affect overlapping portions of objects.

·	Video Post does not support Multipass Depth of Field and Multipass Motion Blur.

VIEWING FILES
·	The Autodesk FLC image file setup depends on the AVI settings for Windows Media™ Player. Since Media Player can be replaced when installing other applications, viewing FLC files can fail at times. To work around this, install QuickTimeÒ 5, which is provided with 3ds max, and use it to view these types of files. QuickTime 5 can convert FLI™ and FLC files, but not CEL files.

XREF
·	Adding an Object XRef of an object, which is itself an Object XRef in the target scene, is not recommended.

·	XRef Automatic Update has more restrictive functionality under Windows 98. XRef objects and scenes can be set to update automatically whenever a file change is detected. Under Windows 2000, this occurs each time the source file is saved. Due to different system notifications in Windows 98, the automatic update only occurs when the source file is closed by exiting 3ds max 5.1 or by loading another file. Manual Update works as expected.

·	When clicking to unbind the highlighted XRef(s) from whichever parent they'd been bound to, the XRef scene does not return to its origin, typically the 0,0,0 world origin of the MAX file scene it came from.

·	Drag and drop when running under Windows 98 requires the Local Intranet security level to be set to Low in IE. This setting can be found in the Internet Options dialog, accessed from  the Tools menu.

·	When using object Xref and Fire Effect Atmospherics, the fire effect information does not always update with the “Update Now” function. It is recommended that Fire Effect Atmospherics are Merged, rather than Xref’d
Notes About MAXScript in 3ds max 5.1 
and the 3ds max 5.1 SDK

Notes About MAXScript (Scripter)

	For all methods and system globals where a file-name string is specified, '/' can be used instead of '\\'. For example: 


getSaveFileName filename:"f:/3dsmax3/images/"

	The following options in the MAXScript tab of the Preferences dialog have no effect:
	Auto Start MAXScript

Load Controller Scripts
Auto Open Listener On Output

	There is an undocumented interface to the mental ray Shader available when the mental ray optional renderer is installed on the system. 


Interface: mentalrayShader
   Properties:
   Methods:
    <boolean>Editor <HWND>window <maxObject>target
    <maxObject>Browser <HWND>window <integer>type
   Actions:

MAXScript known problems and workarounds:

	Due to the change in the default position and rotation controllers to XYZ controllers, some scripts may no longer work correctly. Due to how MAXScript accesses subAnimatable controllers, what previously was returned as a controller may now be returned as a subAnim. An example of this is the ‘center’ subAnim on Bend modifiers. If a simple controller has been applied to this subAnim (for example, a bezier_position), you can directly set the center’s value: b.center = [100,100,0]. With a compound controller (for example, a position_XYZ) you have to set the value of the controller or its sub-controllers: b.center.controller.value = [100,100,0]. This also means that you cannot set the value for center as a construction property: b = bend center:[100,100,0]. Instead, the subAnim’s value will need to be set post 


	Saving a scene with missing scripted plug-in definitions may corrupt the data associated with instances of the missing plug-in definitions.


	If you create a node using the target keyword, the name of the target isn't derived from the name of the object being created. For example:


targetSpot target:(Targetobject())

creates a Target Spot ($Spot01) and target ($Target01). If you create the Target spot in 
the UI, the target name would be $Spot01.Target01.

	Not all properties’ aliases as shown by showProperties are supported for the following objects:
	Free camera

Target camera
Spray particle system
Snow particle system

	SubObject move transform is currently supported only for Editable_Mesh, Editable_Poly, and NURBS.


	SubObject rotate and scale transforms are not supported with: Editable_Mesh, Editable_Poly, Editable_Patch, NURBS, MeshSmooth, and HSDS modifiers.




Notes about the SDK
·	The recommended compiler for development of 3ds max plug-ins is Microsoft Visual Studio 6, but plug-ins may also be compiled using VC7, given some extra considerations.  For an overview of the compatibility issues, please see the tech note available in the TechDocs section of the Sparks Knowledge Base:

http://sparks.discreet.com/search/" http://sparks.discreet.com/search/

·	The following method is not properly clearing a flag if a controller is associated with the parameter. Later attempts to get or set the parameter's value will result in an access violation.

IParamBlock2::Reset(ParamID id, int tabIndex=-1, BOOL updateUI = TRUE, BOOL callSetHandlers = TRUE)

Before calling this method, call the following method to remove the controller, if any:

IParamBlock2::RemoveController(int i, int tabIndex);

For example:

pblock->RemoveController(eFloatParam, 0); 
pblock->Reset(eFloatParam);

·	Version 5 is compatible with version 4.x  with certain exceptions (see the Help file). To make a plug-in for version 5 only, the API number has to be changed:

//#define MAX_API_NUM     8	   // R4
#define MAX_API_NUM     11	   // R5 

The sdkhelp.exe utility (located in maxsdk\help\sdklink.zip) for previous versions has been retired.

	\samples\gup\comsrv\maxclient\maxclient.mak
Requires that you build the COMSRV project first before compiling.

	\samples\modifiers\bonesdef\bonesdef.mak
Requires that you build the MAXComponents project first before compiling.


	To use the hardware shader plug-ins located in \3dsmax4\plugins\hardwareshaders\, you will need to add \3dsmax5\plugins\hardwareshaders\ to your Customize > Configure Paths > Bitmaps/Photometrics and Plug-In panels.


	The ASCIIOUT utility has been retired; the file asciiout.cpp is moved to the retired folder. The current standard text exporter is ASCIIEXP, which is included in the SDK, in maxsdk\samples\impexp\asciiexp.


Class IKMasterControl: Several types of controllers return a non-NULL pointer when GetInterface(I_MASTER) is called on them. To get an interface to this class, use the following code:

ReferenceTarget* ref = NULL;
IKMasterControl* themaster = NULL
if (controller) ref = (ReferenceTarget*)controller->GetInterface(I_MASTER) 
if (ref && ref->ClassID() == IKMASTER_CLASSID) 
	themaster = (IKMasterControl*)ref;

	Creating vertical toolbars is not supported at this time, the standard Windows API could be used instead.


	To create the tree-view child windows that contains a menu bar and toolbars, flag

TVSTYLE_SHOW_CUI has to be used in Interface::CreateTreeViewChild(). If this style
has been set, ItreeviewUI::GetHWnd() can be used to get the handle to the window
housing the CUI elements.

	In order to compile the SDK samples for network rendering (JobAssign and ListJobs), the following must be added to the project: #define DF_MGRPORT 3234.


	To prevent naming conflicts in MAXScript, the ClassName and InternalName returned by a plug-in class should be different from names already used in 3ds max. This will prevent a potential renaming of existing plug-in classes as exposed by MAXScript. For each plug-in class, MAXScript attempts to create a global variable with the name returned by ClassName (and one for the name returned by InternalName if it is different) to represent the class. If a global variable with that name already exists, the superclass name is appended to the class name. Thus, if you create a modifier plug-in class whose name is "Dent", your modifier plug-in class will be assigned the global variable name Dent in MAXScript, and the existing Dent texture map plug-in class will be named DentTextureMap instead of Dent. This name change will break user scripts. To verify that there is no MAXScript name conflict, you can run the following in MAXScript Listener: 


apropos <class name string> implicitWild:false 

If the result is just 'OK', no naming conflict exists.

END
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